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Abstract

This document describes how to use sapthesis.cls, a LATEX document
class for the typesetting of the theses of the “Sapienza University of Rome”.
The official web page of sapthesis is
http://biccari.altervista.org/c/informatica/latex/sapthesis.php.
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1 Introduction

After several years in my faculty I noticed that usually students spend a lot of time
to refine the aesthetic aspect of their LATEX documents instead of focusing on the
content. This is against the philosophy of LATEX, which was created to relieve
the writer from the typesetter’s work. Apart from the time spent, the resulting
documents are obviously all different from each other and good aesthetic results are
not always achieved. This has a negative impact both on the student’s work and on
the university. Moreover in 2007 the Sapienza university changed completely its
logo and a lot of strict graphic rules for official documents were introduced.1

For these reasons I thought that a LATEX class for the theses of my university
would have been a good idea. Sapthesis is the result of my work. Its official
web page is http://biccari.altervista.org/c/informatica/latex/sapthesis.php.
Sapthesis is released under the terms of the latest version of the LATEX Project
Public License.

To give a look to a document composed by sapthesis class, compile one of the
several examples reported in App. 6.

I would like to thank the Italian TEX user group (GuIT) for the help provided, in
particular Enrico Gregorio and Claudio Beccari. I would also thank all the users
who reported bugs and suggestions.

2 Requirements and installation

The simplest way to install sapthesis is by the package manager of your TEX
distribution (TEX Live or MiKTEX). For manual installation see the README file.

The sapthesis package provides: the sapthesis.cls class file; the documen-
tation sapthesis-doc.pdf (this file) and its source code; the logo of Sapienza
university; an English BibTEX style, called sapthesis.bst, which can be used,
obviously, only if you use the BibTEX way to compose your bibliography and if
your thesis is written in English (its usage is not mandatory).

Sapthesis explicitely loads the packages xkeyval, etoolbox, geometry, ifxetex,
xltxtra, fontenc, textcomp, lmodern, caption, graphicx, color, booktabs, amsmath,
fancyhdr. Do not include these packages in the preamble of your document!

1A thesis is not an official document and therefore these guidelines can not be applied (private
communication with Laura Gobbo, Ufficio Stampa e Comunicazione Sapienza Università di Roma).
However some Microsoft Word templates, with a completely different style, are provided. To give a
look to the new Sapienza style see Marchio, identità visiva e sistema grafico and Template tesi.
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3 Usage

A LATEX document based on sapthesis can be compiled only by the commands
pdflatex and xelatex. In this manual only pdflatex will be considered.

As usual, in order to use this class, you need to call it by� �
\documentclass[options]{sapthesis}� �
You have to specify the class options for your case (see Sec. 3.1). Then you
have to provide some fundamental information (title, author, etc. . . ) by specific
commands in the preamble (see Sec. 3.2). Finally, remember to follow a source
code structure similar to those of the examples given in App. 6. Especially the usage
of the commands \frontmatter, \mainmatter and \backmatter is mandatory,
otherwise the page style of the document will be wrong!

This class supports, at the moment, two languages: Italian and English. The
choice of the language is automatic according to the babel package settings. If
babel is not loaded, english is used. See below to override the automatic choice.

3.1 Class options

The following options can be passed to the \documentclass command.

a4paper/a5paper/b5paper Choose one of these three options to set the paper
format. The default value is a4paper.

layout=a5paper/b5paper If, for some reason, it is impossible to print on A5 or
B5 directly (printer not supporting these formats, paper not available, ...), it
is possible to specify the A5 or B5 layout, maintaining the A4 paper format:
some cropmarks will be printed to show where the page should be cut.

draft The usual draft option of the LATEX Standard Classes.

oneside The usual oneside option of the LATEX Standard Classes.

twoside (default) The usual twoside option of the LATEX Standard Classes.

binding=length (zero default binding) The value of this option is an offset of
the text column. It is useful to take into account the margin for the binding
(ask to your bookbinder for information).
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noexaminfo Suppress all the final exam informations. Indeed, by default, Sapthe-
sis shows some information about the final thesis discussion on the back
of the title page. By default it shows the phrase “Thesis not yet defended”.
Otherwise, as explained later, giving the commands \examdate{...} and
\examiner{...} the date and the examiners list are shown.

nodefaultfont Avoid the loading of packages fontenc, textcomp and lmodern.

romandiff See App. 5.

italian / english Explicitly declare the language of the title page. Useful to
write the title page in a language and the thesis in a different language.

3.2 Commands for the title page

As usual, the title page is generated by the \maketitle command. It needs some
information that you can supply by the following commands in the preamble.

\title{...} Mandatory. Title of the thesis. The text is justified, however it is
recommended to insert manual linebreaks (\\) to compose a beautiful title.

\subtitle{...} Optional. Subtitle (try to avoid a subtitle). If both
\subtitle{...} and \alttitle{...} are used, the latter is discarded.

\alttitle{...} Optional. Alternative title (try to avoid an alternative title).
This command, together with the \title{...} command, is typically
used to insert in the frontispiece the title in another language. If both
\subtitle{...} and \alttitle{...} are used, the latter is discarded.

\author{...} Mandatory. Author (student’s name).

\IDnumber{...} Mandatory. ID number (matricola in Italian).

\course{...} Mandatory. Use the official Italian name of the course. Even
though your thesis is in English you should write here the official name of
the course, which normally is in Italian.

\cycle{...} Mandatory only for PhD’s. Use the form: \cycle{XXII}

\courseorganizer{...} Mandatory. Course organizer (for example Scuola di
Scienze Matematiche Fisiche e Naturali). Use \\ to properly break the lines.
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\AcademicYear{...} Academic Year.

\advisor{...} You must specify at least one advisor. If you have more than one
advisor, put several advisor commands in the correct order:
\advisor{Prof. Pippo} \advisor{Dr. Pluto}

\customadvisorlabel{...} Optional. Specify the label for advisors. It can be
used, for example, to print “Relatrice” instead of “Relatore”.

\coadvisor{...} Optional. Co-advisors of the thesis. Same syntax of the
\advisor command.

\customcoadvisorlabel{...} Optional. Specify the label for co-advisors. It
can be used to print “external advisor” or similar labels.

\director{...} Optional. Director of the PhD program, head of the Specializa-
tion degree, or similar. Same syntax of the \advisor command. Avoid its
usage if possible.

\customdirectorlabel{...} Optional. Specify the label for director.

Together with the title page, Sapthesis will also compose an information page
just after the title page. See also the \noexaminfo class option described in a
previous section. Here follow the necessary commands to compose this page.

\examdate{...} Optional. Date of the final exam.
Example: \examdate{16 February 2020}.

\examiner[...]{...} Optional. Specifies the members of the board of examin-
ers of the final exam. Usage similar to \advisor command. The optional
argument can be used to specify the role of that examiner in the commission.

\thesistype{...} Optional. Type of thesis (usually PhD thesis, Master thesis,
and so on).

\ISBN{...} Optional. ISBN

\copyyear{...} Mandatory. Copyright year (usually the graduation year).

\copyrightstatement{...} Optional. Specify a copyright statement that will
be printed in place of the default one.

\versiondate{...} Optional. Date version of the thesis.

5



\website{...} Optional. Thesis website. Automatically hyper-linked if hyperref
package is loaded.

\authoremail{...} Mandatory. Email of the thesis author. It is automatically
hyper-linked if hyperref package is loaded.

\reviewer{...} Optional. Reviewers of the thesis (typically this applies to
PhD theses only). Same syntax of the \advisor command. The list
of the reviewer is preceded by the a text which can be specified by the
\reviewerlabel{...} command.

\extrainfo{...} Optional. This command can be used to insert an arbitraly
long text at the top of the back of the titlepage. For example, in the past it was
used to provide some information for TFA theses (tutor, tutor coordinator,
principal of the school, name of the school, and so on).

3.3 Other commands and environments

\dedication{...} A command to compose the dedication.

abstract An environment to compose the abstract of your document. This
environment has an optional parameter to choose the title of the abstract
section. If you use a language for the abstract different from that of the thesis,
consider the \selectlanguage{...} command provided by the babel
package.

acknowledgments An environment to compose the acknowledgments of your
document. This environment has an optional parameter to choose the title of
the acknowledgments section. If you use a language for the acknowledgments
different from that of the thesis, consider the \selectlanguage{...}
command provided by the babel package.

The sapthesis class defines also the color sapred which is the Sapienza red:
RGB(130,36,51). Example of usage: \textcolor{sapred}{blah blah}

4 Recommendations

• Do not change the default layout.

• Do not load the packages already loaded by sapthesis (see Sec. 2).
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• As you already should know, LATEX can process only documents in pure ASCII.
If you want to insert directly other characters, not included in the 128 ASCII
characters (for example accented letters), you have to use a particular text
encoding for your source file. Then you have to “tell” to LATEX which encoding
you have chosen by the packages inputenc. It is always recommended to
use UTF-8 character encoding and specify this choice also by the magic lines
at the beginning of the source code (see the examples in App. 6).

• Respect the following thesis structure:

– Title page (\maketitle command)
– Dedication (\dedication command)
– Abstract (abstract environment)
– Acknowledgements (acknowledgments environment)
– Table of contents (\tableofcontens command)
– Chapters
– Appendices
– Bibliography

• It is recommended to avoid or limit the acknowledgments in a thesis, it is not
very professional. The dedication should be enough.

• Do not put any preface in your thesis. The preface should be written only by
an eminent expert in the field to comment exceptionally important results of
the student.

• Usually tables and figures are centered. Remember that, according to the
typographic rules, the table captions should be placed above the table, whereas
the figure caption should be placed below the figure.

• If the figure has a small width, it is possible to put the figure caption aside
the figure using the sidecap package (not preloaded by sapthesis).

• Avoid the use of colors unless really necessary. Remember that the figures
should be readable even if they are printed in gray scale!

• Subscripts and superscripts should be in italic if they represent variable
quantities, whereas should be in roman if they are simply labels.
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• The name of operators should be typed in roman. Example: use sin ($\sin$)
instead of 𝑠𝑖𝑛 ($sin$).

• The margin notes are rarely used in scientific documents and should not be
used in a scientific thesis.

• Do not divide the bibliography per chapter unless it is really necessary. This
will save you from wasting a lot of time to prepare your LATEX source code.
Order your bibliography alphabetically according to the first author surname:
this order is very useful, contrary to the other typical order, the citation order.
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5 Other useful commands

Sapthesis provides several useful commands for scientific texts.

\eu Napier’s number, e, in roman.

\iu Imaginary unit, i, in roman.

\der{...}{...} Derivative. The first argument represents the function to derive
while the second the variables separated by commas. The differential
symbol is automatically inserted. Examples: \der{f}{x}, \der{f}{x,y},
\der{f}{*{3}{x}}, \der{f}{*{2}{x},*{2}{y},z}.

\pder{...}{...} Partial derivative. Same syntax of the \der command.

\rb{...} Roman suBscript

\rp{...} Roman suPerscript

\tb{...} Text suBscript

\tp{...} Text suPerscript

\un{...} Useful command to typeset measurement units in the correct way, e.g.
25\un{m/s}, 13\un{kg\,cmˆ{-3}}. It can be used both inside or outside
the math environment. For heavy usage of measurement units and to insert
numbers in the form 1.4e-5, the package siunitx is recommended.

\g Shortcut for the \degree command. Example: 45\g produces 45°.

\C Shortcut for the \celsius command. Example: 37\,\C produces 37 °C. (Not
available in math mode compiling with xelatex).

\A Angstrom. Example: 10\,\A produces 10 Å.

\micro Micro prefix. Example: 7\,\micro m produces 7 µm.

\ohm Ohm. Example: 100\,\ohm produces 100W.

\di Differential symbol with automatic spacing. Example: $\int x \di x$
produces

∫
𝑥 𝑑𝑥. If you prefer the differential symbol in roman (d), you can

use the romandiff document class option.

\x Shortcut for the \times command. E.g.: $7 \x 10ˆ5$ produces 7 × 105.
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6 Examples

PhD thesis in English� �
% !TeX encoding = UTF-8
% !TeX program = pdflatex
% !TeX spellcheck = en_US

\documentclass[binding=0.6cm]{sapthesis}

\usepackage{microtype}
\usepackage{hyperref}
\hypersetup{pdftitle={My thesis},pdfauthor={Francesco Biccari}}

\title{My thesis}
\author{Francesco Biccari}
\IDnumber{123456}
\course{Dottorato di Ricerca in Filologia}
\courseorganizer{Scuola di Dottorato in Scienze Filologiche}
\cycle{XXXVII}
\AcademicYear{2021/2022}
\advisor{Prof. Caio}
\coadvisor{Dr. Sempronio}
\authoremail{pippo@pippo.com}
\copyyear{2022}
\thesistype{PhD thesis}

\begin{document}

\frontmatter
\maketitle
\dedication{Dedicated to\\ Donald Knuth}

\begin{abstract}
This thesis deals with myself.
\end{abstract}

\tableofcontents

\mainmatter
\chapter{Introduction}
...

\backmatter
\cleardoublepage
\phantomsection % Give this command only if hyperref is loaded
\addcontentsline{toc}{chapter}{\bibname}
% Here put the code for the bibliography. You can use BibTeX or
% the BibLaTeX package or the simple environment thebibliography.

\end{document}� �
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Master thesis (Laurea/Laurea Magistrale) in Italian� �
% !TeX encoding = UTF-8
% !TeX program = pdflatex
% !TeX spellcheck = it_IT

\documentclass[binding=0.6cm]{sapthesis}

\usepackage{microtype}
\usepackage[italian]{babel}
\usepackage[utf8]{inputenc}
\usepackage{hyperref}
\hypersetup{pdftitle={La mia tesi},pdfauthor={Francesco Biccari}}

\title{La mia tesi}
\author{Francesco Biccari}
\IDnumber{123456}
\course{Laurea Magistrale in Fisica}
\courseorganizer{Facoltà di Scienze Matematiche, Fisiche e Naturali}
\AcademicYear{2021/2022}
\advisor{Prof. Caio}
\coadvisor{Dr. Sempronio}
\authoremail{francesco.biccari@pippo.com}
\copyyear{2022}
\thesistype{Tesi di Laurea Magistrale}

\begin{document}

\frontmatter
\maketitle
\dedication{Dedicato a\\ Donald Knuth}

\begin{abstract}
Questa tesi parla di me.
\end{abstract}

\tableofcontents

\mainmatter
\chapter{Introduzione}
...

\backmatter
\cleardoublepage
\phantomsection % Give this command only if hyperref is loaded
\addcontentsline{toc}{chapter}{\bibname}
% Here put the code for the bibliography. You can use BibTeX or
% the BibLaTeX package or the simple environment thebibliography.

\end{document}� �
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Specialization thesis in English� �
% !TeX encoding = UTF-8
% !TeX program = pdflatex
% !TeX spellcheck = en_US

\documentclass[binding=0.6cm]{sapthesis}

\usepackage{microtype}
\usepackage[english]{babel}
\usepackage[utf8]{inputenc}
\usepackage{hyperref}
\hypersetup{pdftitle={My thesis},pdfauthor={Francesco Biccari}}

\title{My thesis}
\author{Francesco Biccari}
\IDnumber{123456}
\course{Specializzazione in Fisica Medica}
\courseorganizer{Facoltà di Medicina e Chirurgia}
\AcademicYear{2021/2022}
\advisor{Prof. Caio}
\coadvisor{Dr. Sempronio}
\director{Prof. Pippo}
\customdirectorlabel{Direttore della Scuola di Specializzazione}
\authoremail{francesco.biccari@pippo.com}
\copyyear{2022}
\thesistype{Specialization thesis}

\begin{document}

\frontmatter
\maketitle
\dedication{Dedicated to\\ Donald Knuth}

\begin{abstract}
This thesis deals with myself.
\end{abstract}

\tableofcontents

\mainmatter
\chapter{Introduction}
...

\backmatter
\cleardoublepage
\phantomsection % Give this command only if hyperref is loaded
\addcontentsline{toc}{chapter}{\bibname}
% Here put the code for the bibliography. You can use BibTeX or
% the BibLaTeX package or the simple environment thebibliography.

\end{document}� �
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A A very brief introduction to the TEX world

Many people want to (or are compelled to) write in LATEX without studying a basic
manual. Here follows a very brief introduction to the TEX world.

TEX, the document preparation system designed by Donald Knuth in 1978, is a
program to typeset documents. It is a mark-up language: you write a simple text
decorated with TEX commands (source code) which is then compiled to obtain the
final product, a document in pdf format. LATEX is just a set of macros, written in
TEX, to simplify the writing of the source code: it can be thought as a simpler
programming language with respect to TEX. A source code written in LATEX can be
compiled by several “compilers”: pdflatex (the most common), or xelatex, or
others.

The following list of LATEX manuals, may be especially useful for Italian authors.

• L. Pantieri & T. Gordini, L’arte di scrivere con LATEX, (2017)

• S. Pakin, The comprehensive LATEX symbol list, (2021)

• E. Gregorio, LATEX: breve guida ai pacchetti di uso più comune, (2010)

In order to use LATEX, you have to install a TEX distribution. It contains the
compilers, several fonts and other files needed by the compilers and also many
packages, which can be thought as libraries or extensions of LATEX. The most
famous distributions are MiKTeX (available only for Windows, Linux, and Mac),
TeX Live (available for Windows, Linux, and Mac) and MacTeX (available only for
Mac OS).

Finally we discuss the editor, that is the program used to write your source file.
Since a source file written in LATEX, like in any other programming language, is a
simple text file, you can write your code with any text editor you want (for example
Notepad in Windows). However the suggested editors are:

• TeXworks. Already installed with any TEX distribution. Very simple and
powerful. Use TeXworks if you are not an expert. Enrico Gregorio has
written a very good and brief TeXworks manual in Italian, which can be
found at: http://profs.sci.univr.it/~gregorio/introtexworks.pdf.

• TeXstudio (cross-platform), TeXmaker (cross-platform), TeXshop (only for
Mac), Kile (only for Linux). Powerful editors.

• Avoid other editors unless you know what you are doing!
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Finally we explain how to compile the example documents provided in the
sapthesis package. Double click on one of the .tex file in the examples folder.
TeXworks should start showing the content of that file. The pdflatex compiler
should be automatically selected thanks to the magic lines placed at the beginning
of the file. Now, in order to compile, press the green button. At the end of the
compilation the resulting pdf appears in a separate window. Remember to compile at
least three times, because LATEX needs more than one compilation to correctly resolve
the internal cross references (for example for the table of contents composition, or
when you refer to a figure by the \label – \ref / \pageref mechanism).

Using Overleaf

Overleaf is a collaborative cloud-based online text editor, specifically designed for
LATEX. The compilation of the source file is performed remotely on the Overleaf
servers, by a TeXLive distribution. Therefore, using sapthesis in Overleaf is
straightforward. You don’t need to do anything, the package is already available. For
any reason sapthesis is not available or the version present in Overleaf is outdated,
just copy the files of sapthesis in your remote working directory in Overleaf. Local
files have always precedence with respect to global files.

Using LyX

LyX is an advanced LATEX editor which does not simply show the source code like
any text editor, but instead it renders maths, images, tables and some text formatting
commands. However this “layer” between the writer and the real source code is
sometimes frustrating and many authors discourage the usage of LyX.

Using sapthesis with LyX is quite straightforward.

• Install sapthesis by the package manager of your TEX distribution or manually.

• Copy the file sapthesis.layout in the directory
C:\Program Files\Lyx20\Resources\layouts\
and then, in LyX, click on Tools > Reconfigure. This will add the sapthesis
class in the list of LyX available classes.

• In LyX, first of all, go in Tools > Preferences > Language Settings >
Language and choose “none” in Language package. This step is necessary
because LyX not only loads babel with the desired language, but it passes
the language also as an option for the class! This triggers an error in many
classes.
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• Create a new document and go in Document > Settings > Document Class.
Here you can choose sapthesis as the class for the document and write the
class options.

• Write the preamble in Document > Settings > LaTeX Preamble.

• Create the titlepage inserting the title by the Title item in the LyX left menu.

It is recommended to activate View > Source Pane. This step is not necessary
but it is very useful to observe the LATEX code produced by LyX (on the right choose
“Complete source” or “Preamble”).
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B Frequently Asked Questions

B.1 How can I increase the font size?

The default font used in Sapthesis is Latin Modern. The default font size is 11 pt
using A4 and 10 pt using A5 and B5. At the moment it is impossible to change the
font size unless you modify the Sapthesis class file (sapthesis.cls). The reason
for this choice is to maintain a common format for all the theses.

B.2 How can I increase the line-spacing?

The line-spacing in typography is defined as the distance between two lines. A
strange “tradition” in Italy is to write the thesis with a double line-spacing. This is
an incredibly large number. The lines are so separated that the effect is very ugly.
Two reasons are behind this choice. The first one is that a lot of space is available
for your professor to comment your text. The second one is that, in this way, the
thesis is thicker.

This effect is amplified when you use Microsoft Word because Word defines
the line-spacing in a different way with respect to the typical definition. And
usually people do not know that. Therefore, when you set the value of 2 for the
line-spacing in Word, actually you obtain a line-spacing of 2.34 according to the
normal definition of the term! (Word adds an extra 17% of space, I do not know
why).

Of course this large value of the line-spacing is a nonsense. It is known in
typography that the best value ranges between 1.20 and 1.45. In LATEX the default
line-spacing is 1.20, which means that, if you use a font size of 10 pt, the line-spacing
is 12 pt. In Sapthesis the line-spacing is set to 1.20. Nowadays, professors typically
correct a thesis by using the comment tools of the their pdf viewer. There are still
some who want to print it and want a double line-spacing. In that case, give them a
copy with a double line-spacing but ask them to have the permission to print it in a
more normal line-spacing, in order to save paper.

If you want to change the line-spacing, do not use the \linespread command.
Load instead the setspace package and use, for example, the \onehalfspacing
command.

B.3 Single sided or double sided printing?

A strange “tradition” in Italy is to print the theses only on one side of the paper
sheets. In the past this was justified because a thesis was manually typed by a
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typewriter machine. Today, where the theses are all composed by a computer, this
“tradition” is kept mainly because in this way the professors and the students are
happy to see a thicker book.

Of course this is a nonsense. Not only because the bulky effect is only aesthetic
(if you open the thesis you can see that only one side is printed), but especially
because it is a waste of paper. Moreover, reading a book where only the right page
is printed is quite ugly and strange, isn’t it? (Have you ever seen a book, containing
mainly text, printed single sided?)

The only real reason to print single sided is when a good paper is not available.
Indeed, a low quality paper, like the one typically used for photocopies, has a
grammage of 80 g/m2. It is a little bit semitransparent and this can be a problem
when you print double sided, especially if you have many color images. The best
approach is using a proper paper grammage of 90 g/m2 or 100 g/m2. Ask to the
printing service which type of paper is more suitable to print your thesis double
sided.

B.4 Inverted margins? How much space for binding?

Another typical question regards the margins of the thesis. Quite often the students
(and incredibly also the printing services) complain about the margins of the thesis.
They think that the margins are reversed because in LATEX standard classes, by
default, the inner margin is smaller than the outer margin. The same behaviour,
but with slightly different proportions, is adopted in Sapthesis (see Figure 1). Of
course, they are wrong. This is the correct behavior! Indeed, as you can see in any
book, the sum of the two inner margins should be more or less equal to the width of
a single outer margin. This is for an aesthetic reason. Otherwise the two columns
of text would be too much separated when the book is open.

Figure 1: A4 page layout scheme of UniFiTh class using a zero binding margin.
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At this point the students usually reply “what about the binding margin? The
inner margin should be larger because some space is used by the binding process!”
This is partially true. The effect described above in Figure 1 is what should happen
after the binding process. For this reason there is the documentclass binding
option in Sapthesis (see Section 3.1). Typical values are 6 or 7 mm but it is always
preferable to ask the printing service which is the correct value according to the
binding method (be careful because many printing services are not professional and
suggest arbitrarly binding margin values).

B.5 Numbered introduction and conclusions?

There is a strange “tradition” in Italy to not attribute a number to the Introduction
and Conclusions of a thesis. Probably, only because they are usually short chapters.
So it seems that they do not deserve a proper number like any other chapter.

In my (and not only mine) opinion this is a nonsense. The Introduction and
Conclusions chapters are part of the thesis, and they should be read to properly
understand the thesis. They cannot be skipped. So why don’t attribute a number to
those chapters?

Therefore I suggest to use the following structure of the thesis (which is the
same reported in the examples in Appendix 6).� �
...

\frontmatter
\maketitle
...

% The chapters after the mainmatter command are numbered
\mainmatter
\chapter{Introduction}
\chapter{...}
\chapter{...}
\chapter{...}
\chapter{Conclusions}

\backmatter
...� �

However, if you really want to follow the nonsense of not giving a number to the
Introduction and Conclusions chapter, you can do it in the following way. But keep
in mind that if you do not number the Introduction and Conclusions, you cannot
insert any numbered equation, table, or picture in these chapters. Indeed, all these
objects are numbered with the chapter number: Fig. 1.2, Tab. 3.2, Eq. (4.1), etc. If
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the chapter does not have a number, how can we assign a number to Figures, Tables,
or Equations?� �
...

\frontmatter
\maketitle

% The chapters after the mainmatter command are numbered
\mainmatter
\chapter*{Introduction} % The chapter* does not attribute a number
\markboth{Introduction}{} % This command is necessary for the headings
\chapter{...}
\chapter{...}
\chapter{...}
\chapter*{Conclusions} % The chapter* does not attribute a number
\markboth{Conclusions}{} % This command is necessary for the headings

\backmatter
...� �

Finally, it is worth noting that the first and last chapter of a thesis must not to be
always called Introduction and Conclusions!

B.6 How to reduce the size of the pdf?

Usually, students do not optimize the images of their thesis. This is a very bad
practice and one of the typical consequences is the excessive large size of the final
pdf. The topic is too long to be covered here, however I want to provide a simple
way to reduce a posteriori the file size of the pdf.

Using Ghostscript we can “distill” a pdf file, which means interpreting it and
re-enconding it again. This is just a small list of possible commands (commands are
intended for Windows 64 bit but they can easily applied to other operating systems
changing the name of the Ghostscript executable):� �
BEST QUALITY (Flate image encoding)

gswin64c.exe -q -dNOPAUSE -dBATCH -dSAFER -sDEVICE=pdfwrite -sOutputFile=output.pdf
-dAutoFilterColorImages=false -dAutoFilterGrayImages=false
-dColorImageFilter=/FlateEncode -dGrayImageFilter=/FlateEncode
-dPDFSETTINGS=/prepress -dCompatibilityLevel=1.5 input.pdf� �� �
BEST QUALITY (DECT image encoding)

gswin64c.exe -q -dNOPAUSE -dBATCH -dSAFER -sDEVICE=pdfwrite -sOutputFile=output.pdf
-dPDFSETTINGS=/prepress -dCompatibilityLevel=1.5 input.pdf� �
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� �
LOWER QUALITY (DECT image encoding)
Substitute XXXXXXX with one of the following settings (order of descending quality):
/printer /ebook /screen

gswin64c.exe -q -dNOPAUSE -dBATCH -dSAFER -sDEVICE=pdfwrite -sOutputFile=output.pdf
-dPDFSETTINGS=XXXXXXX -dCompatibilityLevel=1.5 input.pdf� �
B.7 How to create an archivable pdf?

PDF/A is a particular PDF format, standardized by ISO, specialized for use in
the archiving and long-term preservation of electronic documents. Public and
private institutions, including universities, increasingly require this form to archive
electronic documents. There are several levels of PDF/A. The suggested format for
a thesis is the PDF/A-2b.

The best and free way to check if a pdf file is compliant to one of the PDF/A
levels is to use veraPDF, an open source software supported by the most important
PDF associations in the world and funded by the European Commission. This
software is freely available for Windows, Linux, and Mac.

A PDF/A file can be generated directly in LATEX, properly following some rules
(see “Creare file archiviabili con pdfLATEX e LuaLATEX” by Claudio Beccari) however
we do not have enough space to cover this topic here. A faster way is to transform
the file of the thesis in a PDF/A compliant pdf file using Ghostscript. Follow the
following steps:

1. Copy in your working directory an icc color profile. Since the pdf file will be
viewed mainly on electronic screen, you can use a generic sRGB color profile.
You can download one here: https://www.color.org/srgbprofiles.
xalter. Rename it, for example, in srgb.icc.

2. Copy a PostScript definition file, with the instructions to convert the file
in PDF/A, in your working directory. This file, containing all the proper
commands, can be found in your computer. You can find it under the name
PDFA_def.ps in the lib folder of your Ghostscript installation directory
(for example C:\Program Files\gs\gs9.22\lib\typically in the lib sub-
folder). Copy this file in your working directory and rename it! Let us
suppose to rename it in PDFArenamed.ps.

3. Modify the PostScript definition file. Open the PDFArenamed.ps file and
specify the color profile (srgb.icc) and the title of your pdf file. To do that
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use the text editor you prefer. The variables to modify are intuitive and easily
identifiable: /ICCProfile and /Title.

4. Open a terminal and launch the following command� �
gswin64.exe -q -dNOPAUSE -dBATCH -dNOSAFER
-sDEVICE=pdfwrite -sOutputFile=output.pdf
-dPDFA=2 -dPDFACompatibilityPolicy=1
-sColorConversionStrategy=UseDeviceIndependentColor
-sProcessColorModel=DeviceRGB
PDFArenamed.ps input.pdf� �

5. Finally, control that the converted file correctly adheres to the PDF/A format
using the VeraPDF software.
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